Microsoft technologies enable equal opportunities

Catalogue of inclusive tools. Version 2.0
The mission of Microsoft is to give every person and organization on the planet an opportunity to achieve more.

Microsoft has been creating technology for 30 years. We are accountable for billions of users, and every one of them is unique to us. From the very beginning, we think about the accessibility of each product for everyone and strive to ensure that every person with a wide variety of needs has an opportunity to use our tools and achieve more. This principle is fundamental for Microsoft's DNA.

At the same time, inclusion is crucial in education. Modern technology focused on each student’s abilities and needs allows them to build vital skills and prepare for solving various problems in adult life.

Kristina Tikhonova
President of Microsoft in Russia

Welcome

For years, people with special needs have been able to communicate, study, work and solve everyday tasks comfortably with Microsoft accessibility tools. Technologies that allow listening to texts and visualizing information have become allies of users in the learning process.

It is important to note that no extra steps are needed to use accessibility tools — Windows and Microsoft Office 365 software already include everything. Such availability of special features makes it easy to use them on any device, both in an educational organization or office and at home.

Modern technologies allow users with special needs to express their thoughts and wishes, successfully study and work. The accessibility of modern computing solutions for communication in everyday life increases the quality of life of a person with special needs and draws attention to their opinion.

The common view of Microsoft and the Centre “Dorogou Dobra” on the value of the opinion of each person as an individual with their unique characteristics allows combining experience and knowledge to improve the lives of people with special needs.

Technologies that previously existed only in scientific journals have now become a reality. Thanks to Microsoft specialists, children with severe movement disorders can use software that allows them to control computers with their eyes. It significantly expands each child’s opportunities and initiatives in communication and improves the quality of life of the whole family.

Modern computer technologies dramatically improve the rehabilitation processes for children and adults with special needs, allowing them to expand their capabilities. That is why it is vital to combine knowledge and strive to make the world open and accessible to each person with their unique characteristics.

Ekaterina Karetnikova
Head of the Education Department of ROORDi “Dorogou Dobra” in the Kirov region
Table of Contents

6 Introduction
   About this catalogue
   Microsoft products

14 Communication
   Microsoft Teams
   Microsoft Whiteboard
   Microsoft OneNote
   Other tools

26 Vision
   Windows 10 accessibility features
     Display. Make text bigger
     Display. Make everything bigger
     Mouse pointer. Change the size and color of the mouse pointer
     Text cursor. Use the indicator and change the appearance of the text cursor
     Color filters. Use color filters
     High contrast. Use high contrast
   Magnifier
   Narrator
   Read Aloud feature
   Braille
   Other tools

50 Hearing
   Windows 10 accessibility features
     Audio. Volume
     Audio. Mono audio
     Audio. Visual notifications
     Closed captions
   Captions
   Microsoft Teams Live Events
   Microsoft Translator
   Other tools

70 Information Perception and Processing
   Immersive Reader
   Microsoft Lens
   PowerPoint Designer
   Built-in translator for Microsoft Office
   Simplify and personalize Windows
   Focus assist
   Other tools

94 Mobility
   Windows 10 accessibility features
     Keyboard. Use a device without a physical keyboard
     Keyboard. Use Sticky Keys
     Keyboard. Use Filter Keys
     Mouse. Control your mouse with a keypad
     Eye control
   Dictation in Microsoft 365/Office 365 applications
   Tablet mode
   Windows Hello
   General features. Keyboard shortcuts
   Other tools

112 Preparation of Accessible Materials
   Accessibility Checker
   Microsoft Sway
   Other tools
Introduction

Creating an accessible environment and ensuring equal opportunities for everyone through technological innovation is the founding principle of Microsoft.
About this catalogue

An inclusive approach allows expanding opportunities for people with special needs and other users because each person in certain circumstances (trauma, external conditions, etc.) may need special tools. Moreover, based on experience, inclusive technologies are quickly becoming demanded by a wide range of users.

Microsoft products, including Windows, Microsoft Office, Microsoft 365/Office 365, are designed with different needs in mind. They also support special tools and settings that can make it easier and more convenient to interact with PCs and mobile devices, communicate and collaborate in a team.

In education, Microsoft technologies allow creating inclusive classrooms by implementing a student-centered approach to each student and providing equal opportunities for both children and adults. Accessibility features in Windows and Office help educators create a learning environment in which learners can develop independence and creativity, read, learn languages and science.

This updated catalogue contains information about Microsoft inclusive tools that:

- offer accessibility to each user;
- optimize the educator’s work and provide students with independence and empowerment when interacting with the learning environment.

An updated list of Microsoft Accessibility Features (in English) aka.ms/AccessibilitySway
Please note: you can use the built-in translator in the Microsoft Edge browser to translate text by these links to the desired language.
Announced in the summer of 2021, Windows 11 will build on the foundation of Windows 10 and offer new features for security, performance and productivity. Those who have eligible Windows 10 devices can upgrade to Windows 11 for free. Most of the recent Windows 10 devices on sale will be ready to upgrade to Windows 11 after its release date. Windows 11 is expected to include the familiar Windows 10 inclusive features with enhancements and additions.


Microsoft Office

The Microsoft Office product portfolio includes perpetual licenses and subscriptions for home use, businesses, educational institutions and other users.

Eligible educational institutions can receive Office 365 subscriptions at preferential terms.

Perpetual licenses

Perpetual licenses such as Office 2019 and the next version, Office 2021, which will be released in 2021, offer a suite of applications (Word, Excel, PowerPoint, and others) for Windows or macOS computers, with a traditional one-time purchase option. Applications under these perpetual licenses receive security updates and patches (as part of their support periods) but do not receive new features.

Microsoft Office applications include several accessibility tools.

Windows operating system and modern devices

Windows 10 is an operating system for home, work and school with an intuitive interface and a large variety of built-in inclusive tools that allow customizing a personal digital environment.

Windows 10 unleashes its full potential on modern devices. For example, gadgets with a touch screen (some laptops, 2-in-1 devices, all-in-ones, etc.) can be controlled by finger touches, which may be more convenient for some people than using a mouse or keyboard. And digital pen-enabled devices allow adding texts, diagrams, drawings and notes to documents using natural pen-like movements.

Subscriptions

Subscriptions, such as Microsoft 365 and Office 365, can include Office applications as well as online services. Applications and services under subscriptions can be used both on PCs and mobile devices (tablets and smartphones), and are also available as web versions. Applications and services under subscriptions are always up-to-date and allow receiving new features almost every month.

Microsoft 365 and Office 365 subscriptions include Microsoft cloud services for communication and collaboration. Depending on edition, subscriptions may include Microsoft Teams, OneDrive, Sway and other applications and services.

A range of inclusive tools is available in Microsoft 365 and Office 365 applications and services.

More about purchasing a subscription for your educational institution: aka.ms/office-365-education-plans-ru.

Office Online

Office Online is a suite of browser-based versions of Office applications and services. These include the web versions of Word, Excel, PowerPoint and other applications. Office Online is free for home use. Microsoft 365 and Office 365 subscribers also receive enhanced features of the web versions of Office applications and services.

Types of accounts used in Microsoft products

There are two main types of accounts: personal accounts created and managed by users themselves, and school or work accounts created by an administrator (IT admin) of the organization.

Personal accounts

A personal Microsoft account (MSA) is a free account used to access multiple Microsoft services, including Outlook.com webmail, Office Online, as well as Skype, OneDrive, Xbox Live, Bing, Windows and Microsoft Store.

How to create a Microsoft account

1. Go to account.microsoft.com and choose Create a Microsoft account.
2. If you want to create a new email address, choose Get a new email address, press Next and follow the instructions.

School or work accounts

School or work accounts can be used by organizations to access Microsoft 365/Office 365 products. These accounts are assigned to users (employees, educators, students, etc.) by an administrator (IT admin).
Communication

Ensuring equal access to tools and their capabilities is vital for user communication and interaction in any process, such as learning or business, and in any format — face-to-face, distant, blended or hybrid.

- Online interaction in Microsoft Teams
- Online collaboration on Microsoft Whiteboard
- Create, fill, and share OneNote digital notebooks
- Overcome language barriers when collaborating with a translation application
Teams’ accessibility features (Immersive Reader (IR), Voice Messages, High Contrast, etc.) make it easier for users with special information perception and processing needs, as well as visual and hearing needs to communicate. While the universal features in Teams (conferencing, chatting, group collaboration, text translation) simplify interaction for all categories of users, including people with situational needs, unique work styles or specific personal preferences.

Required components, software and hardware

The Microsoft Teams application can be installed on Windows and macOS computers and iOS and Android mobile devices.

Microsoft Teams is also available for the web.

More features are available for recent versions of Windows, macOS, iOS, Android and Internet browsers.

Download Microsoft Teams at aka.ms/installteams.

Hardware requirements for Microsoft Teams setup:
aka.ms/hardware-requirements-teams-ru.

Microsoft Teams features differ for users with work, school and personal accounts. More details: aka.ms/teams-differences-ru.

Users from organizations, including educational organizations, can use their school or work account to sign in to Microsoft Teams. As for personal, family or home tasks, users can log in with a personal Microsoft account.

Microsoft Teams

Microsoft Teams is a tool for remote communication, audio and video meetings and conferences, information management and team collaboration.

Users can connect to Teams from anywhere in the world with Internet access, from computers and mobile devices.

The capabilities of Microsoft Teams are broad. Besides communication in group and personal chats, online meetings and conferences, this service allows addressing such tasks as:

- upload files and collaborate in a shared space;
- record events and view the recording at any time;
- group work and individual programs (in Teams for Education);
- training sessions in the face-to-face, blended, hybrid or distant format (in Teams for Education);
- connect and configure additional programs necessary for collaboration (such as applications or websites).
Text translation in Teams

Foreign language translation is available for chat messages in Teams.

How to enable the translation of messages

In Teams for desktop computers

Select More options (three dots in the upper part of the message), and then Translate. It will show a translation of the message into the language that you’ve set for Teams.

To choose a language to translate the messages to, select More (three dots in the upper part of the message) → Settings → General → Translation and choose a language.

To return a translated message to the original language, tap More options and select See original (language).

In Teams for mobile devices

Tap and hold the message that you want to translate, and then tap Translate.

The language to translate the messages to is set up in the mobile version the same way as in the desktop version.

To return a translated message to the original language, tap and hold the message, then tap See original (language).

Reflect application in Microsoft Teams

Reflect is a free application available for installation in Microsoft Teams that allows educators to receive regular feedback from a learner or a group of learners.

With Reflect, educators can facilitate and assist learners to successfully interact and easily check both the general emotional state of learners and their attitude to a specific topic, such as homeschooling, homework, current events or changes in the team.
Microsoft Whiteboard

Microsoft Whiteboard is a digital canvas for remote user collaboration across devices. Users can work with the Whiteboard individually too, for instance, demonstrate, illustrate and capture ideas at online events.

In the learning process, an online digital whiteboard helps educators maintain student attention throughout the whole lesson. In particular, this is relevant for users with special information perception and processing needs.

Required components, software and hardware

Microsoft Whiteboard can be used as a separate application available for Windows computers in the Microsoft Store and for iOS devices in the AppStore, and as a web application available for users in organizations at whiteboard.microsoft.com and built into Microsoft Teams.

The application runs on devices with the latest versions of most browsers, including Microsoft Edge, Chrome, Firefox, and Safari.

To use the Microsoft Whiteboard application on Windows 10 computers or iOS devices, you must sign in with your personal Microsoft account or your Microsoft 365/Office 365 (work or school) account.

How to use Microsoft Whiteboard

Open an existing board or create a new one by clicking the + button on the toolbar.

You can save time by creating boards in advance and then simply opening them during classes or meetings.

More about Microsoft Whiteboard
aka.ms/whiteboard-help-ru

YouTube tutorials on using Microsoft Whiteboard efficiently
aka.ms/whiteboard-on-YouTube
Microsoft OneNote is an application designed to create, edit and share universal digital notebooks. There are several available versions: for computers, mobile devices and browsers.

On OneNote pages, a user can add and organize text, spreadsheets, audio, video, files, pictures, links and more, as well as organize online collaboration with others.

OneNote provides a wide range of features that vary by platform and version, including:

- optical character recognition from pictures, screenshots and scanned images;
- handwriting recognition;
- insertion and calculation of simple mathematical equations;
- audio recording and video notes;
- adding drawings and handwritten notes;
- inserting images, videos and other files
- and much more.

Notebooks in OneNote for Windows 10

Microsoft OneNote supports inclusive technologies such as Text Translation, Immersive Reader, Voice Recorder in Microsoft 365, and Accessibility Checker. These tools are described in detail in other sections of the catalogue, namely:

- Text Translation feature is similar to Microsoft Teams translation feature, Communication section, page 18;
- IR — see in Information Perception and Processing section, page 72;
- The Dictation feature — see in Mobility section, page 104;
- Accessibility Checker — see in Preparation of Accessible Materials section, page 114.
Required components, software and hardware

There are several versions of OneNote:

- a web version;
- classic desktop version for computers — included with Microsoft Office subscriptions and also available for free at onenote.com/download;
- OneNote application for Windows 10 is included with this operating system.

Most versions of OneNote require sign-in with a personal, work, or school account.

Other tools

Microsoft’s digital inclusive tools are often versatile and assist users with different needs. This section contains tools that can also help users with special communication needs. Some of these tools are discussed in more detail in other sections.

Microsoft Translator

The free Microsoft Translator application helps language learners overcome language barriers and participate in multilingual discussions using any available device: a computer, tablet or smartphone.

For more details on how this application works, see the Hearing section, page 67.
Vision

Microsoft products include features that can simplify computer interaction for blind or visually impaired users and users with other special visual needs.

- Zoom in on the entire screen or specific parts of it
- Ability to make the appearance of interface elements and text more clear and contrasted
- Converting the program interface and on-screen navigation according to the needs of the user
- Listening to a voice description of the screen contents by using Narrator
- Connecting peripheral devices such as a Braille display to computers running Windows 10
**Windows 10 accessibility features. Vision settings**

The Windows Settings section with settings for users with special needs is called Ease of Access. The Ease of Access section in Windows Settings contains settings applied to Windows and settings for separate tools such as Magnifier and Narrator.

Ease of Access allows customizing Windows 10 for a better user experience with a range of special needs, including special vision needs.

**Required components, software and hardware**

Various versions of Windows include Ease of Access. More features are available in recent versions of Windows.

This section highlights several Ease of Access settings using Windows 10 version 20H1 as an example.

Learn which version of Windows operating system you are running at aka.ms/windows-versions-ru.

---

**How to access Ease of Access**

The fastest way to open the Ease of Access section is with the keyboard shortcut:

![Keyboard shortcut](image)

You can also access this section by selecting:

![Start menu](image)

Start menu

To open the main Settings window press:
### Display. Make text bigger

Settings → Ease of Access → Display

You can use this setting to increase the text size within the interface elements of the Windows 10 operating system and in applications. This setting does not affect the overall size of components on the screen. Please note that some applications don’t support increased font sizes.

**Before increasing the text size**

**After increasing the text size**

---

### Display. Make everything bigger

Settings → Ease of Access → Display

You can use this setting to increase the size of all elements on the screen (buttons, captions, icons, menu items, etc.). Please note that the recommended scale and available scaling options depend on the size and resolution of the device display.

**Before applying this setting**

**After applying this setting**

---

How to change the text size
[aka.ms/text-size-ru](aka.ms/text-size-ru)

How to make everything bigger
[aka.ms/screen-ru](aka.ms/screen-ru)
Mouse pointer. Change the size and color of the mouse pointer

Settings → Ease of Access → Mouse pointer

This setting allows changing the size and appearance of the arrow pointer: make it larger, change the color from standard white to black or another, and also add color inversion to make the pointer more visible at the borders of different fields.

An example of a standard pointer

An example of a larger and brighter pointer

Text cursor. Use the indicator and change the appearance of the text cursor

Settings → Ease of Access → Text cursor

This setting allows changing the appearance and size of the cursor — a vertical bar that displays the place of text input — to add color markers to it, as well as to make it thicker, one or more letters wide. It makes it much easier to find it in the text.

An example of a standard cursor

An example of a larger cursor with a color indicator

How to change the color and size of the pointer

aka.ms/screen-ru

How to change the appearance of the cursor

aka.ms/screen-ru
Color filters. Use color filters

Settings → Ease of Access → Color filters

Color filters change the colors of everything displayed on the screen as if overlaying a filter on top. For example, the entire screen can become black and white or inverted (like on a negative film).

There are six color filter options available to suit users with different color perceptions, including three filter options for color blindness.

High contrast. Use high contrast

Settings → Ease of Access → High contrast

High contrast is a mode which both changes the colors of elements, icons and buttons in the menu and adds additional selection methods, such as button borders.

There are four default high contrast theme options with different color combinations.

If none of the default options work, you can customize the colors of various screen elements, such as text and hyperlinks, based on one of the standard themes.

You can enable the selected mode in the Settings section or by using the following keyboard shortcut:

Alt + Shift + Prt Sc
Magnifier

Magnifier is a built-in Windows tool that can enlarge a part of the screen to make words and images bigger and easier to see.

Magnifier also supports the inversion mode (color inversion) and includes Narrator’s capabilities for reading text in documents and on websites and narrating the names of interface elements (in supported applications).

Magnifier works in three modes: full-screen, as a separate window, or as a lens that moves around the screen with the mouse pointer.

Required components, software and hardware

Magnifier is available in different Windows versions. More features are available in recent versions of Windows.

This section highlights several Magnifier settings using Windows 10 version 20H1 as an example.

Learn which version of Windows operating system you are running at aka.ms/windows-versions-ru.

How to use the Magnifier
aka.ms/magnifier-ru

A video tutorial on Magnifier in Windows 10
aka.ms/magnifier-video-tutorial
How to enable and configure Magnifier

To test Magnifier on a device running Windows 10, use the following keyboard shortcut:

![Magnifier settings](image)

To turn off Magnifier, click on the cross in the upper right corner of the Magnifier panel.

To change settings (for example, choose a display mode or turn on color inversion), open the Magnifier settings window. The fastest way to do it is to use the following keyboard shortcut:

![Magnifier settings](image)

_A course on Magnifier in Windows 10_  [aka.ms/magnifier-course-1]

---

Narrator

Narrator allows interacting with a computer by listening to a voice-narrated description of interface elements, commands, and document contents. A user can interact with a computer via a keyboard while receiving audio feedback through the speakers or headphones.

**Required components, software and hardware**

Narrator is available in different Windows versions. More features are available in recent versions of Windows.

This section highlights several Narrator settings using Windows 10 version 20H1 as an example.

Learn which version of Windows operating system you are running at [aka.ms/windows-versions-ru](aka.ms/windows-versions-ru).
How to enable and configure Narrator

To test Narrator on a device running Windows 10, use the following keyboard shortcut:

![Keyboard shortcut icon]

Use the same keyboard shortcut to turn off the Narrator.

When Narrator is launched, by default the Narrator’s home page opens with short and full versions of the user’s guide.

Page interface with Narrator on

Note: text narration (text-to-speech) is also available:

- in Magnifier,
- in Immersive Reader in various applications,
- in Microsoft Edge browser.

In the latest versions of Word, PowerPoint and Outlook, a beta version of text dictation is also available.

Note: text narration (text-to-speech) is also available:

- in Magnifier,
- in Immersive Reader in various applications,
- in Microsoft Edge browser.

In the latest versions of Word, PowerPoint and Outlook, a beta version of text dictation is also available.

How to use Narrator

aka.ms/narrator-ru

A course on Narrator in Windows 10

aka.ms/narrator-course-1
Read Aloud feature

Read Aloud allows listening to text by using the text-to-speech technology, which makes it possible for users with special visual needs, as well as with the special information perception and processing needs, to perceive a written text as spoken words.

Required components, software and hardware

Read Aloud is available in recent versions of Microsoft Office applications such as Word and Outlook and in Microsoft Edge browser.

Note: Read Aloud is also available in Immersive Reader (including the built-in version in Word and Microsoft Edge). For more information about the Immersive Reader, see the Information Perception and Processing section, page 72.

How to enable Read Aloud

In Microsoft Edge browser

To listen to the text on a web page, use the following shortcut:

```
Ctrl + Shift + U
```

Or select Settings and more (three dots), and then select Read Aloud from the drop-down list.

To listen to the text that you want to read, select it, right-click, and select Open in Immersive Reader from the context menu.

A toolbar appears at the top of the page after Read Aloud is started: buttons to pause, move to the next/previous paragraph and voice options that allow changing the reading speed and selecting a Narrator’s voice.

Note: Read Aloud can be used with PDF documents that contain text in the same way as in Microsoft Edge.
In Microsoft Word

Go to the Review tab and click the Read Aloud button on the top toolbar or use the following keyboard shortcut:

Alt + Ctrl + Space

Press it again to turn reading aloud off.

More details on how to manage listening with keyboard shortcuts: aka.ms/listen-to-word-documents-ru.

Note: unlike Microsoft Edge, Microsoft Office includes only standard electronic voices built into Windows.

In Microsoft Outlook

Open an email and click the Read Aloud button on the Review tab, or place the cursor at the beginning of the email text and use the following keyboard shortcut:

Alt + Ctrl + Space

Most braille displays can execute 12 Narrator commands for navigation and interaction with applications. Displays that have a braille keyboard allow using it to input text or execute commands.

Required components, software and hardware

Braille reading is available on computers running Windows 10. Narrator in Windows 10 supports braille displays from several vendors.

The list of supported braille displays is available at aka.ms/braille-ru.
Other tools

Microsoft’s digital inclusive tools are often versatile and assist users with different needs. This section contains tools that can also help users with special vision needs. Some of these tools are discussed in more detail in other sections.

Immersive Reader

Immersive Reader is a multifunctional tool that helps to ease the perception of texts. It is built into various Microsoft applications.

IR capabilities include increasing the font size and choosing a user-friendly color theme (combination of text and background colors) for web pages and documents.

For more details on this tool, see the Information Perception and Processing section, page 72.
Windows Hello

In Windows 10 settings, you can select Windows Hello authentication as the login option. This will allow you to use faster, easier and more secure login options, such as PIN, face or fingerprint recognition, instead of traditional passwords. A special infrared camera or a fingerprint sensor on a computer are required to log in with a face or a fingerprint.

For more details on how to use Windows Hello, see the Mobility section, page 108.

Tell me what you want to do in Microsoft Office

Tell me is a special search box that helps to find not just the right word in a document, but also a command (function) in the application and even the help information on it. For example, you can find the required command simply by the first letters of its name, without having to search on various menu tabs.

Voice Recorder

Voice recorder application in Windows and audio and video recording feature in OneNote allow recording speech like if using a regular voice recorder.

Dictation feature

The Dictation feature in recent Office applications allows converting speech to text, for example, for Word documents and Outlook emails.

For more information on how this tool works, see the Mobility section, page 104.

Microsoft Sway

Sway is an online service that helps to quickly create interactive presentations. Accessibility view makes it easier for users with special vision needs to view presentations in Sway:

- the color scheme changes to black and white — the contrast of the text increases;
- interactive elements are marked with focus indicators so that users who only use the keyboard know which element they are on.

For more information on how this tool works, see the Preparation of Accessible Materials section, page 117.

Microsoft Lens

The Microsoft Lens mobile application is a “pocket scanner” for documents, whiteboards and photos. Microsoft Lens also includes Immersive Reader with the ability to extract text from snapshots of documents, enlarge it and listen to it.

For more details on this tool, see the Information Perception and Processing section, page 82.
Hearing

For hearing-impaired or deaf users, Windows 10 and Microsoft Office provide special tools and features.

- Audio and visual notification settings
- Automatically generated and closed captions
- Real-time text-to-speech conversion
- Real-time speech translation to another language
- Features to improve audio quality for online meetings
Windows 10 accessibility features. Hearing settings

The Windows Settings section, which contains settings for users with special needs, is called Ease of Access. The Ease of Access section in Windows Settings contains both settings applied to Windows and settings for separate tools such as Magnifier and Narrator.

Windows 10’s accessibility features are designed to help hearing-impaired or deaf users improve their computer experience.

Required components, software and hardware

Accessibility features are available in various versions of Windows. More features are available in recent versions of Windows.

This section highlights several Ease of Access settings using Windows 10 version 20H1 as an example.

Audio. Volume

This setting allows adjusting the volume level of the device — just like using a keyboard shortcut or by clicking the speaker icon in the control panel. Note: on different keyboards, the volume is controlled by different keys. For example, these can be separate keys with a speaker icon or the F10 and F11 keys also with a speaker image.

Audio. Mono audio

This setting disables the stereo sound, thereby making the audio identical in the left and right speakers of the device. It allows hearing everything, even if the user is using only one earbud or headphone.

To enable or disable this setting, move the slider to the right or left, respectively.

Audio. Visual notifications

Notifications, which in this case are audio signals, warn users of a certain event occurring on the computer. For example, a brief audio signal from Windows can notify the user about an error. For hearing-impaired and deaf users that may not hear these signals, Windows can notify them visually by flickering the screen (imitating a flash).
This setting allows enabling these visual notifications (without disabling the audio signals) and selecting one of three options for displaying them: make the header of the active window, the whole window or the entire screen flash.

To enable this setting, click on the drop-down menu and select the appropriate option. To disable it, click on the drop-down menu again and select the No Visual Alert option.

Note: this option is not suitable for users with high epileptic activity, as screen flickering can trigger a seizure.

Closed captions

Settings → Ease of Access → Closed captions

This section of settings allows customizing the look of captions, for example, when the built-in player plays a video with captions or in a video with captions embedded in a PowerPoint slide.

You can choose the text color, transparency level, font, size, and other text effects (for example, add a drop shadow to the text).
Captions

In PowerPoint

Microsoft PowerPoint allows creating colorful presentations using a range of multimedia content: text, images, pictures, audio, animation and video.

Some PowerPoint features can be used in an inclusive context and make preparing and viewing presentations easier for users with special needs. These features include:

- automatic conversion of the speaker’s speech into captions and embedded captions for videos;
- quick set-up and design of slides, including templates and the Designer function to simplify the process of preparing presentations;
- Immersive Reader (PowerPoint for the web).

Some of these features are discussed in other sections. This part is dedicated to captions.

Automatic captions in PowerPoint in Microsoft 365

PowerPoint in Microsoft 365/Office 365 provides the capability for automatic conversion of speech into captions, which are displayed during a presentation. It allows following the speech of the speaker in text format, which also makes it possible for the hearing-impaired or deaf to understand the presentation.

When enabled, this function recognizes words pronounced by the speaker in real-time via the microphone that is built into or connected to the computer and displays those words on the screen next to the currently displayed slide. You can change the position of captions on the screen. It also supports automatic translation of captions into other languages.

At this moment, the application supports the conversion of 18 languages, including Russian and other complex languages, some of which are still in the early stages of development and will be refined in future versions. Despite any potential errors in early versions, the conversion is correct for most commonly pronounced words in Russian.

Presentation with automatic captions

How to configure automatic captions in PowerPoint

aka.ms/autosubs
Required components, software and hardware

Automatic subtitles are available:

1. In the PowerPoint application on computers running Windows 10 with a Microsoft 365/Office 365 subscription (version 16.0.11601.20178 or higher);
2. In the PowerPoint application on computers running macOS (version 16.22.127.0 or higher) with a Microsoft 365/Office 365 subscription;
3. In PowerPoint for the web in Microsoft Edge, Google Chrome 34+, Mozilla Firefox 25+ browsers.

For automatic captions to work, you need a working microphone that is built-in or connected to a computer, as well as an Internet connection.

How to enable automatic captions in PowerPoint

Open the presentation, go to the Slide Show tab, select the Always Use Subtitles check box, start the slideshow — and speak. Your words will appear below the slide.

The recognition quality is improved when the volume of your speech is higher than the volume of the background noise. So try to get close to the microphone, or better use a separate microphone/headset. You can select the required microphone in the same place, in the caption settings.

Closed captions in PowerPoint

In recent versions of PowerPoint, you can add captions and subtitles as separately prepared files to videos embedded in slides or create captions right in the application. It will help people with special hearing needs more easily understand videos in slideshows and is generally useful for anyone who prefers to follow the text in a video by reading it rather than listening.
In Live Presentations

PowerPoint for the web (for Microsoft 365/Office 365 users) includes Live Presentations. After launching a Live Presentation, other users (viewers) can connect to it using a QR code or a link and follow the slide show right in the browser (on a computer or mobile device). The speaker’s speech automatically converts into captions that viewers can see.

In addition, viewers can scroll and enlarge the slides, send live reactions and provide the presenter with feedback after the end of the slideshow.

The ability to enlarge slides (on the viewer side), view captions and access what was previously shown make Live Presentations more convenient for use in an inclusive space.

Required components, software and hardware

Live Presentations are supported in PowerPoint for the web on computers running Windows or macOS, in browsers with these or later versions: Microsoft Edge version 80, Google Chrome version 72, Mozilla Firefox version 68 or Opera version 60 and later. Safari is not currently supported for presenters but works great for viewers.

A presenter needs a Microsoft 365/Office 365 subscription to use Live Presentations. Viewers don’t need a subscription to view Live Presentations.

How to start a Live Presentation

1. Open your presentation in PowerPoint for the web, go to the Slide Show tab and select Present Live.
2. A QR code and a corresponding short link will appear on the screen, by which viewers can connect to the Live Presentation.
3. When you see that everyone is connected, you can start the slideshow by clicking on the Slides button in the lower left corner.

Live captions are enabled by default, you will see them on the screen, and viewers will see them on their devices and will be able to scroll through them.

Note: the speaker’s voice is not broadcasted during Live Presentations.

More about Live Presentations in PowerPoint
aka.ms/live-presentations-ru
In Microsoft Stream

Microsoft Stream allows uploading video files to the cloud storage and adding subtitles and titles to videos so that information is available to all groups of users. Stream helps users find the video they need based on keywords and grant specific users access to a video, among other useful tasks.

Video with subtitles in Stream

How to add subtitles to a video file in Stream

1. In Stream, find the video you want to edit.
2. Click on the three-dot icon and then the pencil icon to update video details.
3. In the Options window, upload subtitles by selecting a language and uploading your file.

Note: automatic subtitles in Russian are not yet supported in Stream.

Required components, software and hardware

Microsoft Stream for the web works in Microsoft Edge and recent versions of Chrome and Safari on computers running Windows and macOS and on iOS and Android mobile devices. In addition, the Microsoft Stream application is available for iOS and Android.

Note: Microsoft 365 applications and services will not support Internet Explorer 11 starting August 17, 2021.

Plans that include Microsoft Stream and prices are available at aka.ms/enterprise-office365-plans-ru.
Microsoft Teams Live Events

Microsoft Teams Live Events is a separate type of meetings designed for one-to-many communication, where a presenter demonstrates presentation materials and accompanies the demonstration with voice, and meeting participants can ask questions in a moderated chat.

To make participation in Live Events accessible to all users, including those with special hearing needs, Teams provides several tools: subtitles and the ability to broadcast video for reading sign language.

Required components, software and hardware

Microsoft Teams is available on Windows, macOS, iOS and Android devices, and for the web.

Teams Live Events are only available on some Microsoft Office 365 plans, such as Office 365 A3 and Office 365 A5 for education.

Teams Live Events settings

Automatic captions in Teams Live Events

Users with special hearing needs and different language proficiency can follow what Teams Live Event participants are saying with real-time captions.

How to enable automatic captions in Teams Live Events

1. Go to Meeting and select Advanced Options.
2. Select the Enable Dynamic Subtitles. You can choose from 50 languages on the list.

Note: now it is possible to use subtitles in the Russian language in Teams Live Events.
Other recommendations

If users with special hearing needs attend your meeting or Teams Live Event, there are a few simple tips to follow to help make your event more accessible.

1. Switch on your video (a broadcast from the speaker’s webcam) so that users with special hearing needs can lip-read.
   
   You can enable or disable your camera using the keyboard shortcut:
   
   Ctrl + Shift + O
   
2. Mute the sound when you are not speaking to avoid generating background noise.
   
   You can enable or disable sound using the keyboard shortcut:
   
   Ctrl + Shift + M
   
3. Avoid multiple speakers at the same time and signal a change of speaker.
4. Introduce yourself before saying anything for the first time.
5. Speak slowly, clearly, and directly into the microphone.
6. If attendees or presenters in the meeting are using sign language, do not turn on the blur/replace background option so that the gestures are distinguishable.

Live Event Transcript

After the Live Event is over, users can download a file with the text of all voice messages spoken during the meeting.
Required components, software and hardware

The Translator application can be downloaded for free on iOS and Android mobile devices. Translator is also available for the web.

How to use the Translator application

Log into the application and select one of the options to suit users with special hearing needs.

Start a conversation

Log in and enter your name and language. Share the conversation code with other participants. Speak or type — other participants will see your messages in the selected language.

Join a conversation

To join a conversation, ask the host of the conversation for a code, and then enter or scan it. When you join the conversation, you will see everything that the other participants are saying.

Voice recording

You can enable voice recording even if you are not participating in the conversation. Select the language for translation, the number of microphones (one if the speakers speak the same language, two if the speakers speak two languages) and an active microphone (if the speakers speak several languages).

Other tools

Microsoft's digital inclusive tools are often versatile and assist users with different needs. This section contains tools that can also help users with special hearing needs. Some of these tools are discussed in more detail in other sections.

Dictation feature

The Dictation feature in recent Office applications allows converting speech to text, for example, for Word documents and Outlook emails.

For more information on how this tool works, see the Mobility section, page 104.
Information Perception and Processing

Windows 10 and Microsoft Office include a number of features that can simplify interaction with a computer for users with special cognitive needs, namely those with impaired writing and reading skills (for example, with optical dysgraphia, dyslexia, etc.) and special attention needs. In common sense, all of these are special information perception and processing needs.
Immersive Reader

A large number of users may find it difficult to understand text information in documents and on websites. It may refer to the reading process itself. For example, users may have difficulties focusing their vision on a specific line in the text, reading may be hindered by tightly-spaced lines and characters or lengthy lines, and the specific colors of the background and text may be uncomfortable or indistinguishable for some users. There may be other difficulties associated with perceiving and understanding text information.

These and other similar difficulties when reading can be alleviated by the Immersive Reader tool.

Immersive Reader capabilities include the following:

- Emphasize lines (Line Focus). The tool visually distinguishes 1-5 lines of text (this can be compared to using a ruler to move from line to line on a paper text to simplify reading).
- Increase the space between lines and characters, and customize line width.
- Read text aloud (digital narrator) with the option to choose a specific voice and reading speed.
- Configure the colors of the background and text.
- Customize the size of text.

Required components, software and hardware

Immersive Reader is available in several Microsoft applications, including Microsoft Word, OneNote for Windows 10, Microsoft Edge browser, Microsoft Lens application for iOS and Android mobile devices. Most of Immersive Reader capabilities are available in all the listed applications.

More about Immersive Reader: aka.ms/learning-tools-ru.

Availability and features depend on the platform and application.

Note: the standard OneNote application (2016 and 2013) supports IR when the free Learning Tools add-in is installed.

More about the add-in installation: aka.ms/install-learning-tools-one-note.
In Microsoft Edge browser

Immersive Reader is available in the classic version of the Edge browser as well as in the Chromium-based Edge.

How to enable Immersive Reader in the Edge browser

Switch to the Reading View by clicking the book icon in the address bar or by using the following keyboard shortcuts:

- **in classic Edge**: 
  - Ctrl + Shift + R

- **in new Edge**: 
  - F9

In OneNote for Windows 10

Immersive Reader in OneNote for Windows 10 has an expanded set of capabilities. These include highlighting parts of speech and a dictionary that lets you highlight a word to hear its pronunciation and translate it into one of the supported languages, and also provides a small picture illustrating the meaning of the word.

How to enable Immersive Reader in OneNote

Open your Notebook, then open or create a page containing text and switch to the View tab. Select Immersive Reader.

![OneNote reading text aloud](image)

![OneNote: picture dictionary](image)

A video tutorial on Immersive Reader (aka.ms/immersive-reader-video-tutorial)

A course on how to use Immersive Reader (aka.ms/immersive-reader-course-1)
In Microsoft Word

The Immersive Reader is also available in Word 2016, Word 2019, and Word for Microsoft 365 for Windows and macOS, as well as in the web version of Word. The capabilities of the tool vary in different applications and on different platforms.

Languages and products supported by Immersive Reader can be found at aka.ms/immersive-ru.

How to enable Immersive Reader in Microsoft Word

Open a document, switch to the View tab and select Immersive Reader.

In PowerPoint for the web

Although Immersive Reader cannot be tested in the classic version of PowerPoint, it is available in the web version of the application.

For more information on using Immersive Reader in PowerPoint, see aka.ms/immersive-reader-powerpoint-ru.

How to enable Immersive Reader in PowerPoint for the web

There are three ways:

1. Choose a piece of text — select one or more objects on a slide that contain text, or one or more slides — click the View tab, and then select Immersive Reader.

2. Use the shortcut: 

3. Right-click an object containing text or part of it, and then choose Open in Immersive Reader from the context menu.
In Microsoft Teams

With Immersive Reader in Microsoft Teams, users can listen to texts of chat messages or assignments.

How to enable Immersive Reader in Teams

For a message

1. Hover over the message or tap it with your finger on a touchscreen device.
2. Select Advanced Options (three dots) and then Immersive Reader.

For an assignment

Microsoft Teams for education contains an Assignments feature that allows educators to assign tasks or tests to students.

If you are a student, open the assignment and select Immersive Reader.

If you are an educator, open the assignment and select the student and then Immersive Reader.

More about Immersive Reader in Microsoft Teams

aka.ms/immersive-reader-teams-ru
In Outlook for the web
Immersive Reader in Outlook for the web allows listening to the text of emails, as well as increasing the spacing between lines and words, highlighting parts of speech, and splitting words into syllables for more convenient reading.

How to enable Immersive Reader in Outlook for the web
Sign in to your office.com account, select the Outlook app, open or compose an email, click the More Options button (three dots), and then select Open in Immersive Reader.

In Microsoft Forms
Microsoft Forms is an online service that allows educators and learners to quickly and easily create tests, surveys, questionnaires, and more.

Microsoft Forms provides users with special information perception and processing needs with Immersive Reader.

How to enable Immersive Reader in Microsoft Forms
1. Open any survey or test and select the more options icon (three dots), then click Open in Immersive Reader.

2. Hover over any part of the text in the survey or test and then click on the Immersive Reader icon that appears (in the form of a book with a speaker).
Microsoft Lens supports five modes:

- **Whiteboard mode** — to take pictures of handwritten notes on whiteboards and flipcharts;
- **Document mode** — to create snapshots of documents, as well as other printed materials, including articles in magazines and pages of books;
- **Actions mode** — to extract text or a table from an image;
- **Photo mode** — to create aligned snapshots of photographs;
- **Business card mode** — to extract contact information from business cards.

**Required components, software and hardware**

Microsoft Lens is available for Android and iOS tablets and smartphones.

Microsoft Lens (previously known as Office Lens) is a mobile application developed by Microsoft which turns a smartphone into a portable scanner for documents, business cards, whiteboards and flipcharts. Microsoft Lens capabilities include improving the quality of images, recognition and storage of text displayed on them. This application also features Immersive Reader capabilities.

For instance, it allows using a smartphone to take a picture of text (paper document, journal article, sign, etc.) and send it to Immersive Reader. The text is then converted to digital format, which enables the following:

- The text can be modified for convenient viewing: it can be magnified, the space between lines and characters can be increased, and text can be displayed in various color combinations (such as white text on a black background).
- The text can be improved for better hearing — it can be read aloud by a digital narrator whose specific voice and speed can be changed.
- Other tools of Immersive Reader can be applied to the recognized text, which can improve concentration and focus retention, and provide the ability to switch in the process of working with information.
How to use Microsoft Lens

1. Open the application and choose the mode.
2. Take a photo in the application or select an existing photo.
3. Set the crop borders.
4. Edit the photo.
5. Select the appropriate export option.

Scanning in Document mode

Immersive Reader in Microsoft Lens

To test Immersive Reader, open the Microsoft Lens application, choose Document mode, move your smartphone’s camera over text that you want to read, take a picture and select the Immersive Reader function when exporting.
How to use PowerPoint Designer

1. Open the presentation file or create a new file and go to the Design tab.

2. On the top toolbar on the right select Design Ideas.

When you use PowerPoint Designer for the first time, you will be prompted for permission to provide you with various ideas for designing your presentation. If you want to use Designer, select Enable.

To disable Designer, select File → Options, click the General tab in the PowerPoint Designer section and clear the Automatically show me design ideas check box.

PowerPoint Designer

Designer is a built-in feature in recent versions of PowerPoint that speeds up the slide creation process and empowers users to design presentations. Designer automatically suggests design ideas for a presentation as the user adds content to the slides.

Out-of-the-box design ideas allow people with special information perception and processing needs to focus on content rather than layout, and users with special mobility needs can more easily cope with slide designs.

Required components, software and hardware

Designer works in desktop versions of PowerPoint for Microsoft 365 or Office 365 on Windows and macOS computers, in PowerPoint for the web, and in PowerPoint for iOS and Android devices.
Built-in translator for Microsoft Office

Recent Microsoft Office applications feature a built-in Translator that provides the ability to translate selected texts with a service based on artificial intelligence. Users of Word 2019 and Word for Microsoft 365 or Office 365 can translate the entire document. It makes it easier to work with texts in different languages, including for users with special information perception and processing needs.

Required components, software and hardware

Built-in Translator is currently available for Word, Excel, OneNote, PowerPoint, and Outlook (availability and features may vary by version).

Translation of web page texts is available in the Edge browser.

Simplify and personalize Windows

It is possible to reduce distractions and make interaction easier with customization of settings in the Simplify and personalize Windows section which can be found in Settings → Ease of Access → Vision. For example, it is possible to disable animation, transparency and auto-hide scroll bars. It might be relevant for users with special information perception and processing needs.
Focus assist in Windows 10 allows customizing the appearance of system notification windows on the screen, including turning them off. Disabling pop-up notifications helps users with special information perception and processing needs not to be distracted by objects that pop up and/or move on the screen, such as notifications.

How to enable Focus assist

1. Click on the Action center icon on the taskbar.
2. Select Focus assist to see the available options:
   - Priority only
   - Alarms only
   - Off

Note: if you do not see the Focus assist tile, you may need to first select Expand.

Focus assist settings can also be changed by pressing:

- Start → Settings → System → Focus assist

Or by entering Focus assist in the search bar on the taskbar.
Other tools

Microsoft’s digital inclusive tools are often versatile and assist for users with different needs. This section contains tools that can also help users with special information perception and processing needs. Some of these tools are discussed in more detail in other sections.

Microsoft Sway

With accessibility features in Microsoft Sway users with special information perception and processing needs can:

- change the layout to vertical to focus on certain elements;
- break groups of specific elements (for example, a slideshow) into parts to make it easier to access the content;
- disable unnecessary animation, so as not to be distracted by it.

For more information on how this tool works, see the Preparation of Accessible Materials section, page 117.

Read Aloud feature

Read Aloud allows listening to text using text-to-speech technology.

For more details on Read Aloud, see the Vision section, page 42.

Microsoft Translator

Microsoft Translator is a free application that allows translating text, voice, conversations, camera photos, and screenshots into over 70 languages.

For more details on how Translator works, see the Hearing section, page 67.

Tablet mode

Tablet mode makes it easier to use the touch screen in Windows.

Note: Tablet mode has been removed from Windows 11 but continues to work in earlier versions of Windows.

For more details on Tablet mode, see the Mobility section, page 106.

Windows Hello

In Windows 10 settings, you can select Windows Hello authentication as the login option. It will allow you to use faster, easier and more secure login options, such as PIN, face or fingerprint recognition, instead of traditional passwords. A special infrared camera or a fingerprint sensor on a computer are required to log in with a face or a fingerprint.

For more details on how to use Windows Hello, see the Mobility section, page 108.

Other tools
Mobility

Many features in Windows 10 and supported applications can make interaction with a computer easier for users with special mobility needs.

- Features to dramatically reduce errors when typing and using a computer
- Hardware and software solutions that allow interacting with a computer using eye control
- Applications that make it easier to enter text information using speech recognition
- Windows interface setting to make it easier to interact with the software
- Applications that make it easy to create visuals and presentations for users with special mobility needs
- Converting the program interface and on-screen navigation according to the needs of the user
Windows 10 accessibility features. Interaction settings

The Windows Settings section which contains settings for users with special needs is called Ease of Access. The Ease of Access section in Windows Settings contains both settings applied to Windows and settings for separate tools such as Magnifier and Narrator.

With Windows 10’s accessibility features users with mobility limitations can dramatically reduce the number of errors when typing and using their computer.

Required components, software and hardware

Various versions of Windows include Ease of Access. More features are available in recent versions of Windows.

This section highlights Ease of Access using Windows 10 version 20H1 as an example.

Learn which version of Windows operating system you are running at aka.ms/windows-versions-ru.

Keyboard. Use a device without a physical keyboard

Settings → Ease of Access → Keyboard

In this section, it is possible to enable the On-Screen (virtual) keyboard, which the user can work with using the mouse, touch on the touch screen or special controllers (joysticks, etc.). The On-Screen Keyboard has a full layout with all the basic keys.

For easy typing of keyboard shortcuts (for example, Ctrl + C, Ctrl + V), On-Screen Keyboard supports Sticky Keys by default. This can be useful when the user cannot press these keys at the same time (for example, when using the mouse). Sticky Keys feature allows entering keyboard shortcuts by pressing the desired keys in sequence, one after another, rather than simultaneously.

How to enable On-Screen Keyboard

To test On-Screen Keyboard, use the following keyboard shortcut:

To close On-Screen Keyboard, repeat the same key combination or click on the cross in the upper right corner of the keyboard window.

Learn how to use the On-Screen Keyboard at aka.ms/keyboard-ru.
Keyboard. Use Sticky Keys

Some users may find it difficult to enter keyboard shortcuts (for example, Ctrl + C, Ctrl + V) on a regular physical keyboard. For example, in the case where the user may find it difficult to press several keys simultaneously or when they can operate the keyboard with only one finger.

When Sticky Keys is enabled, it becomes possible to enter keyboard shortcuts by pressing the desired keys sequentially, one after the other, rather than simultaneously.

If the check box Allow the shortcut key to start Sticky Keys is checked, you can press the Shift key five times to turn Sticky Keys on or off.

More details about Sticky Keys feature
aka.ms/input-ru
Some users may experience difficulties when entering text due to difficulty in controlling movements and involuntary movements. The Filter Keys settings in Windows 10 can make working with a computer easier for these users by ignoring accidentally repeated keystrokes or accepting only a long press that lasts within a set time.

Other settings in this section include filtering for specific toggle keys, displaying indicators, and more.

**Examples of various Filter Keys settings**

**Problem: unintentional long key press**

The user, while typing, pressed the key with the letter A and unintentionally held their finger on the key for longer than the usual short moment.

- **With default settings**
  The letter will be entered many times as long as the finger presses the key: aaaaaaa

- **With Filter Keys enabled**
  The letter will be entered once for every single keystroke: a

**Problem: unintentional repeated keystrokes**

The user, while typing, unintentionally pressed the key with the letter B several times in a row instead of the one they needed.

- **With default settings**
  The letter will be re-entered as many times as the number of keystrokes was made: bbbbb

- **With Filter Keys enabled**
  All keystrokes made, for example, more than once per second, will be ignored, the letter will be entered once: b

**Problem: accidentally pressing unwanted keys**

The user who wishes to type the letter C, along with it, due to brief involuntary movements, unintentionally pressed other keys.

- **With default settings**
  All letters pressed will be entered: csvzc

- **With Filter Keys enabled**
  Only the letter will be entered, on the key of which the finger was held, for example, for at least one second, in this case one letter: c
Mouse. Control your mouse with a keypad

Settings \(\rightarrow\) Ease of Access \(\rightarrow\) Mouse

If the user has difficulty positioning the pointer/cursor using the mouse, it can be done with the keys on the numeric keypad (NumPad). When this feature is enabled, a user can move the pointer (in the form of an arrow or cursor) using the arrows on the numeric keypad. Note: this requires a keyboard with a separate numeric keypad (see the picture).

Using the numeric keypad to control the mouse. The user moves the pointer to the right using the 6 key

Actions that can be performed using the keys on the numeric keypad

1. Left key stimulates the left mouse button
2. Right key stimulates the right mouse button
3. Middle key stimulates the middle button
4. Page up button activates the last screen reader
5. Page down button activates the next screen reader
6. F1 button activates the first screen reader
7. F2 button activates the next screen reader

Eye control

Settings \(\rightarrow\) Ease of Access \(\rightarrow\) Eye control

Paralyzed and other users deprived of the ability to interact with the computer using body movements can control a computer with eye movements.

The use of this technology requires special supported equipment (sensors capable of tracking eye movement, the so-called eye trackers). When such a sensor is connected to a Windows 10 computer, a separate interface becomes available with large buttons specially configured for eye control and have additional features.

Among these features is a special screen reader that allows communicating with other people. It allows typing the desired phrase with eyes (or selecting among the ready-made phrases) and converting it into speech.

The list of supported sensors is available in the guide at aka.ms/eye-control-ru.

How to set up the system for comfortable keyboard and mouse operation aka.ms/input-ru

A video tutorial on Windows 10 settings youtube.be/klyFrI03gQ

A course on the use of Windows 10 settings aka.ms/accessibility-settings-course-3
Dictation in Microsoft 365/Office 365 applications

The Dictation feature in recent Office applications allows converting speech to text, for example, for Word documents and Outlook emails.

The Dictation feature can be useful for users who have difficulty typing on a regular keyboard. It helps users add text to documents, emails, notes and presentations by speaking the desired words and commands aloud.

Note: built-in speech recognition support has been announced in Windows 11. Integration of this tool into the OS will make it possible to enter text using speech in various applications.

Required components, software and hardware

The Dictation feature is built into the following applications:

- Word for Microsoft 365/Office 365 for Windows and macOS computers, Word for the web, Word mobile for iOS and Android;
- PowerPoint for Microsoft 365/Office 365 for Windows computers, PowerPoint for the web;
- OneNote for Windows 10, OneNote for the web;
- Outlook for Microsoft 365/Office 365 for Windows and macOS computers, Word mobile for iOS and Android.

The Dictation feature requires a microphone and Internet access.

Note: Russian language may not be available on all platforms at this time. In Russian, the Dictation features work in a beta version, therefore speech recognition and the placement of punctuation marks may not always be accurate.

How to enable and configure Dictation

To test the Dictation feature, for example, in Microsoft Word, launch the application and open or create a document. And then click the Dictation button on the right side of the top toolbar on the Home tab. Start dictating — the text will appear on the page. Press the Dictating button again to disable speech recognition.
Tablet mode

Tablet mode enhances the Windows experience — applications open in full screen, and the elements of the Windows interface and supported applications become larger, making it more convenient to control it with finger touch.

Required components, software and hardware

Tablet mode is available in Windows 10 and is primarily relevant for devices with a touch screen (including 2-in-1 devices and tablets with keyboards). On supported devices, Tablet mode is automatically enabled when the keyboard is disconnected or the device is transformed into an appropriate mode.

It was announced that Tablet mode won’t be featured in Windows 11, but new features will be added for a comfortable touchscreen experience.

How to enable Tablet mode

Tablet mode can be automatically enabled on supported devices. To manually enable Tablet mode in the Action center on the taskbar, press the following keyboard shortcut:

\[ \text{Windows} + \text{A} \]

To close an application in Tablet mode, drag it to the bottom of the screen.
**Windows Hello**

In Windows 10 settings, you can select Windows Hello authentication as the login option. This will allow you to use faster, easier and more secure login options, such as PIN, face or fingerprint recognition, instead of traditional passwords. A special infrared camera or a fingerprint sensor on a computer are required to log in with a face or a fingerprint.

**Required components, software and hardware**

1. Windows 10 computer.
2. Built-in or connected special infrared camera with facial recognition technology — to set up Windows Hello facial recognition.
3. Integrated or connected fingerprint reader — to configure Windows Hello fingerprint recognition.

**General features. Keyboard shortcuts**

Accessibility keyboard shortcuts make it easier to navigate a computer when using a keyboard or supportive devices. A user can use them to quickly turn on and off the desired function (for example, Magnifier, High Contrast) without having to go to the Settings section.
A keyboard shortcut that enables and disables On-Screen Keyboard (on On-Screen Keyboard)

A keyboard shortcut that enables On-Screen Keyboard (on a physical keyboard)

Other tools

Microsoft's digital inclusive tools are often versatile and assist users with different needs. This section contains tools that can also help users with special mobility needs. Some of these tools are discussed in more detail in other sections.

PowerPoint Designer

PowerPoint Designer makes it easier for users with special mobility needs to manage slide designs.

For more details on this tool, see the Information Perception and Processing section, page 86.
Preparation of Accessible Materials

Windows 10 and Microsoft Office include several options for creating accessible content that make it easier for users with different special needs to interact with the computer.

- Review of materials and recommendations to improve accessibility
- Preparation of accessible presentations and filling them with various multimedia content
Accessibility Checker

Accessibility Checker is available in current Microsoft Office applications. It is designed to analyze the readability of documents, identify formatting and structure issues that can make information processing harder, and offer recommendations to make documents accessible to users with special needs.

This tool will be useful for educators when developing learning materials for inclusive classrooms that include learners with special visual and information perception or processing needs.

Required components, software and hardware

Accessibility Checker is available in:

- Word, Excel, PowerPoint, Outlook, OneNote desktop applications available in Office 2019, Office 2016, Microsoft 365, and Office 365 (Windows/macOS);
- Office mobile applications (Android/iOS);
- Office Online;
- Visio for Windows, Sway and SharePoint.

The capabilities of this tool vary by application and platform.

How to use Accessibility Checker

This section demonstrates the capabilities of the Accessibility Checker using the current version of Microsoft Word as an example.
Enable Accessibility Checker

To test the Accessibility Checker in Word, open or create a document, go to the Review tab, and click the Accessibility Checker button on the top taskbar. You’ll see a list of errors, warnings, and tips with how-to-fix recommendations for each of them.

Fix Errors

To eliminate accessibility errors and warnings, select an issue on the list, and then the Additional Information section will appear at the bottom of the pane with information about the required fix and options to perform it. Note: additional information may not be displayed in full, so you should scroll to the bottom.

Background accessibility check mode

To be notified of an accessibility issue in your document while you work on it, select Show me accessibility warnings while I work check box in the Accessibility Checker pane.

You will then be able to see the accessibility check data on the status bar (the bar at the bottom of the document) and open the tool with one click on it and see the results of the check performed in the background.

A similar workflow applies to other applications where the Accessibility Checker is available.

Microsoft Sway

Microsoft Sway is an online Microsoft service designed to create colorful interactive online presentations that allows collecting content from different sources in a single file that can be viewed on any device in a convenient format.

Using various elements as a basis (text, video, audio and pictures), users can independently or collaboratively create reports, presentations and projects, as well as share them.

Sway presentations are only available online, each presentation has an individual link.
Accessibility features of Microsoft Sway helps users with different needs:

- users with special information perception and processing needs can better perceive the material through the use of video and audio files, as well as interactive content;
- users with special visual needs can change the size of the font and images, enable a contrasting background, add audio content;
- automatic adaptation of content to the size and orientation of the screen makes it more convenient to perceive and navigate (swipe) on various types of devices, including touch screens of mobile devices.

Required components, software and hardware

Sway is free for all users with a personal Microsoft account, but users with a Microsoft 365/Office 365 subscription have access to enhanced features.

A modern web browser, such as Microsoft Edge, is suitable for Sway.

Accessibility view

Accessibility view makes it easier for users with special visual and information perception and processing needs to view the Sway presentation.

How to enable Accessibility view

When viewing in Sway, click on Options (gear-shaped icon) in the upper left corner and turn on Accessibility view. After that, the design of the Sway presentation will be simplified, and the scrolling mode will change to vertical.

Other tools

Microsoft digital inclusive tools are often rich in functionality and can be useful both for use by users with special needs and the preparation of accessible materials. This section contains tools for preparing accessible materials. Some of these tools are discussed in more detail in other sections.

Microsoft OneNote

Microsoft OneNote is an electronic notebook that allows collaboration.

For more information on how this tool works, see the Communication section, page 22.
Links usage note

Some links in this catalogue lead to articles translated using automatic machine translation. Unfortunately, the quality of machine translation does not always allow you to accurately convey the content of source materials. We apologize for any inaccuracies and errors.

You can switch to the original versions of articles in English in various ways:

- by clicking on the link to the original page, usually located in the “Notes” section;
- by changing the language to English in the lower-left corner of the web page;
- simply by replacing the /ru-ru/ combination in the page address (in the browser’s address bar) with the /en-us/ combination and pressing Enter.

Microsoft technologies enable equal opportunities

Catalogue of inclusive tools

If you have any questions regarding inclusive tools in Microsoft, please send an email to mrin@microsoft.com.